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Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of 

semiconductor products and application examples.  You are fully responsible for the incorporation of these circuits, software, 
and information in the design of your equipment.  Renesas Electronics assumes no responsibility for any losses incurred by you 
or third parties arising from the use of these circuits, software, or information. 

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics 
does not warrant that such information is error free.  Renesas Electronics assumes no liability whatsoever for any damages 
incurred by you resulting from errors in or omissions from the information included herein. 

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights of 
third parties by or arising from the use of Renesas Electronics products or technical information described in this document.  No 
license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of 
Renesas Electronics or others. 

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.  
Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such alteration, 
modification, copy or otherwise misappropriation of Renesas Electronics product. 

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”.  The 
recommended applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.   
“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 

equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots etc. 
“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-

crime systems; and safety equipment etc. 
Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to 
human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may cause serious property 
damages (nuclear reactor control systems, military equipment etc.).  You must check the quality grade of each Renesas 
Electronics product before using it in a particular application.  You may not use any Renesas Electronics product for any 
application for which it is not intended.  Renesas Electronics shall not be in any way liable for any damages or losses incurred 
by you or third parties arising from the use of any Renesas Electronics product for which the product is not intended by Renesas 
Electronics. 

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, 
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation 
characteristics, installation and other product characteristics.  Renesas Electronics shall have no liability for malfunctions or 
damages arising out of the use of Renesas Electronics products beyond such specified ranges. 

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have 
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions.  Further, 
Renesas Electronics products are not subject to radiation resistance design.  Please be sure to implement safety measures to 
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a Renesas 
Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire control and 
malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.  Because the evaluation 
of microcomputer software alone is very difficult, please evaluate the safety of the final products or systems manufactured by 
you. 

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility 
of each Renesas Electronics product.  Please use Renesas Electronics products in compliance with all applicable laws and 
regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive.  
Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with applicable laws 
and regulations. 

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose 
manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations.  You should not use 
Renesas Electronics products or technology described in this document for any purpose relating to military applications or use 
by the military, including but not limited to the development of weapons of mass destruction.  When exporting the Renesas 
Electronics products or technology described in this document, you should comply with the applicable export control laws and 
regulations and follow the procedures required by such laws and regulations. 

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or otherwise 
places the product with a third party, to notify such third party in advance of the contents and conditions set forth in this 
document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as a result of 
unauthorized use of Renesas Electronics products. 

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas 
Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document 
or Renesas Electronics products, or if you have any other inquiries. 

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-
owned subsidiaries. 

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 

(2012.4) 



 

How to Use This Manual 
 

Readers This manual is intended for user engineers who want to understand the features of the 

RL78/I1A in order to design and develop its application systems and programs. 

 

Purpose This manual is intended to give users an understanding how to use Applilet EZ for DALI 

Control Gear and of the features described in the Organization below. 

 

Organization This manual is broadly divided into the following parts. 

 Overview 

 Installation 

 Starting and Ending 

 Applilet EZ for DALI Control Gear operation 

 Windows reference 

 

How to Use This Manual It is assumed that the readers of this manual have general knowledge of electrical 

engineering, logic circuits, and microcontrollers. 

 

To understand the overall features of Applilet EZ for DALI Control Gear 

→Read this manual in the order of the CONTENTS. The mark "<R>" shows 

major revised points. The revised points can be easily searched by copying an 

"<R>" in the PDF file and specifying it in the "Find what:" field. 

 

To learn the details of the hardware features of the RL78/I1A 

→Refer to RL78/I1A User’s Manual (R01UH0169E). 

 

Conventions Data significance:  Higher digits on the left and lower digits on the right 

 Active low representation: xxx (overscore over pin or signal name) 

 Note:  Footnote for item marked with Note in the text 

 Caution:  Information requiring particular attention 

 Remark:  Supplementary information 

 Numerical representation:  Binary ... xxxx or xxxxB 

   Decimal ... xxxx 

   Hexadecimal ... xxxxH 

 



 

Related Documents 

 

The related documents indicated in this publication may include preliminary versions. However, preliminary 

versions are not marked as such. 

 

Documents Related to Devices 
Document Name Document No. 

Japanese English 

RL78/I1A User’s Manual; Hardware R01UH0169J R01UH0169E 

 

Documents Related to Development Hardware Tools 
Document Name Document No. 

Japanese English 

RL78/I1A DC/DC LED Control Evaluation Board User’s Manual R01UH0363J R01UH0363E 

 

 

 
Caution1. For details about DALI-2 EXPANSION BOARD FOR EZ-0012, contact your local Renesas Electronics 

sales representative. 
 
Caution2. The related documents listed above are subject to change without notice. Be sure to use the latest version 

of each document for designing. 



 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Applilet and CubeSuite are a registered trademark of Renesas Electronics Corporation. Windows, Internet Explorer, 

and Excel are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other 

countries. Pentium is a trademark of Intel Corporation in the United States. 
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CHAPTER 1 OVERVIEW 

1. 1 Overview 
 

Applilet EZ for DALI Control Gear is a tool used to automatically generate software for microcontrollers for DALI 

communication and to write programs. 

By specifying mode on the GUI, Applilet EZ for DALI Control Gear can be used to easily generate the programs that 

control the software for microcontrollers that control DALI communication and LEDs at a constant current. It can also 

be used to automatically write the generated software to the flash memory in microcontrollers via a USB cable and to 

check operation by using an evaluation board. 

By using Applilet EZ for DALI Control Gear, the labor hours for developing DALI communication software, controlling 

LEDs, and checking operation can be significantly reduced. In addition, application systems for LED lamps and 

illumination that use microcontrollers can be evaluated without microcontroller expertise. 

 

 

 

PC (GUI) 

Evaluation board 

(Y-RL78-DCDC-LED / EZ-0012) 

USB cable 

<Configuration example> 
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1. 2 Host Machine, Software, and Hardware Configurations 
 

The host machine, software, and hardware configurations for using Applilet EZ for DALI Control Gear are shown 

below. 

 

(1) Host machine 

 OS: Windows 10 (32-/64-bit mode) 

 CPU, Memory:   Must satisfy the recommended requirements for each OS 

 USB: USB 1.1 interface or later 

(2) Software 

 Applilet EZ for DALI Control Gear (this software) 

 Compiler/integrated development environment 

<Renesas Electronics> 

Integrated Development Environment: CS+ 

Compiler:   CC-RL Note 1 

 Renesas Flash Programmer 

 ············· Software for flash memory programming 

 Board driver  

              ············· Driver used to make the host PC recognize the evaluation board  

                      (Y-RL78-DCDC-LED / EZ-0012) 

(3) Hardware 

 Evaluation board 

RL78/I1A DCDC LED Control Evaluation Board ( Y-RL78-DCDC-LED / EZ-0012 ) 

 ·································· This is an evaluation board for LEDs that uses the RL78/I1A.  

Red, green, and blue LEDs are mounted on the board. The LEDs can be 

controlled by using the internal features of the L78/I1A and an FET without the 

constant-current driver IC. 

DALI-2 EXPANSION BOARD FOR EZ-0012 

 ·································· This is an optional board that supported DALI-2 Control gear for 

Y-RL78-DCDC-LED / EZ-0012. This is needed when test using official DALI 

tester. 

 

 
Notes1. Applilet EZ for DALI Control Gear may not operate depending on the versions of the complier. 

 
Cautions1. It is recommended that the latest service pack be installed for any OS. 
Remarks1. For details about how to obtain compilers, and integrated development environments, contact 

your local Renesas Electronics sales representative. 
2. For details of the evaluation boards, refer to each user’s manual. 

＜R> 
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CHAPTER 2 INSTALLATION 

2. 1 Installing Application 
 

The following applications must be installed to use Applilet EZ for DALI Control Gear. 

 Microsoft Visual Studio 2013 Visual C++ Redistributable Package 

 Applilet EZ for DALI Control Gear 

 Compiler, integrated development environment 

 

 

Remark For details about how to obtain compilers, and integrated development environments, contact your 

local Renesas Electronics sales representative. 
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2. 1. 1 Installing Visual C++ Redistributable Package 

Install Visual C++ Redistributable Package, which is required for using the Applilet EZ for DALI Control Gear. 

 

(a) Download the required files 

Download following files required for installation from the Microsoft website. 

 

(1) Visual Studio 2013 Visual C++ Redistributable Package installer 

Vcredist_x86.exe 

 

(b) Install Visual C++ Redistributable Package 

When "Vcredist_x86.exe" is double-clicked, "Visual C++ redistributable package Setup" dialog box is 

displayed. 

 

 
 

After confirming the license terms, when agreeing, check "I agree to the license terms and conditions" 

and click [Install]. 

Proceed with the installation by following the instructions that will be displayed in the wizard window. 
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2. 1. 2 Installing Applilit EZ for DALI Control Gear 
Double-click the AppEZHCD_V90J.msi file to start the installation wizard of Applilet EZ for DALI Control Gear. 

 

 
 

Click the [Next] and proceed with the installation by following the instructions that will be displayed in the wizard 

window. 
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2. 1. 3 Windows [start] menu and shortcut icon 

When installing of the application has been completed normally, the following folder will be copied into the 

specified installation folder. 

 

Figure2-1 Windows [start] Menu 

 

 
 

The following shortcut icon is displayed on the Windows desktop. 

 

Figure2-2 Shortcut Icon 

 

 
 

2. 2 Installing USB Driver 
 

USB driver is required when using an evaluation board. The USB driver for evaluation board is stated in the disk 

media provided or in an e-mail message. 

The first time that the host machine is connected to the evaluation board via the bundled USB cable, Windows’ 

[Found New Hardware Wizard] appears, prompting for installation of the USB driver. 

Proceed with the installation by following the windows that will be displayed. 

 

 

2. 3 Uninstall 
 

To uninstall Applilet EZ for DALI Control Gear, Compiler go to the Windows Control Panel and select [Apps & 

features]. 
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CHAPTER 3 STARTING AND ENDING 

3. 1 Starting 
 

To start Applilet EZ for DALI Control Gear, go to the Windows [start] Menu and select [All Programs] →[Programs] 

→[App EZ DALI Ver1.0] (refer to Figure2-2 Windows [start] Menu), or double click the shortcut icon on the 

Windows Desktop (refer to Figure2-3 Shortcut Icon). 

Once Applilet EZ for DALI Control Gear is started, the following Main window opens. 

 

Figure3-1 Main Window When Starting 
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3. 1. 1 Setting up at the first startup 
 

(a) Flash programming setting 
The COM Port connected to the flash memory programmer or the board is specified here. 
On the [Setting] menu, select [Flash Program…] .The following dialog box will be displayed. 

 

 
 

Select the connection method from the list box [Tool:]. 
 

 
 

When selecting [E1], the [Power supply:] item is displayed. 
 

 
 
If not supplying power from the E1, sets the [None], and if supplying, set according to the input voltage of 
the board to be used. 
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If selecting [COMx], [COM Port:] item is displayed. 
COM port that is currently connected to the PC is displayed in the [COM Port] list. Select the COM port to 
be used. 

 
If setting ends, click [OK]. 

 
 
3. 2 Ending 
 

To exit from Applilet EZ for DALI Control Gear, go to the Main window’s [File] menu and select [Exit]. 
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CHAPTER 4 APPLILET EZ FOR DALI CONTROL GEAR        
DALI CONTROL GEAR OPERATION 

This chapter describes the operation flow, from automatically generating object codes (*.hex) by using Applilet EZ for 

DALI Control Gear and writing to the flash memory, up to checking operation by using the evaluation board. 

 

4. 1 Operation Flow 

 
 

  

Start Applilet EZ for DALI Control Gear 

Setting up the evaluation board 
Menu -> [Project] -> [cpu] 

 
Refer to 4.2 

Setting up at the first startup (refer to 3.1.1) 

Setting DALI Dimming mode 

 
Chose ↓ 

  
Refer to 4.3,Chapter 5 

 

 
Save the project 

Generation, writing, and evaluation (refer to 4.4) 
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4. 2 Setting Up the Evaluation Board 
 

In the menu, select [Project] and then [CPU] to set up the evaluation board in the dialog box below. 

Performing this setup updates the specified mode displayed in the main window. 

 
(1) Target: 

Select the evaluation board to use. 

 

(2) Device: 

If an evaluation board is selected, the mounted microcontroller is displayed. (This setting cannot be 

changed.) 

 

(3) Clock Source: 

Select the clock to use. This setting might be fixed depending on the setting of (1). 

 

(4) Frequency (MHz): 

Select the frequency. This setting might be fixed depending on the setting of (1) and (3). 

 

(5) Channel X: 

Specify the channels to enable by selecting their [Enable] checkboxes. 

Specify the color of the lighting of each channel by using the [Color] buttons. 

These settings might not be selectable or changeable depending on the setting of (1). 

Enter the max current level of each channel in [Limit]. 

* This setting may be unavailable, depending on the board. 

 

(6) Enable ‘On Chip Debug’.: 

If this checkbox is selected, a program that enables on-chip debugging is generated. 

(1) 
(2) 
(3) 
(4) 

(5) 

(6) 
(7) 
(8) 
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(7) All Channel Synchronized.: 

If this checkbox is selected, the brightness of all selected channels will be the same. 

If only one channel is selected, this checkbox is disabled. 

 

(8) Logarithmic dimming control.: 

Select this checkbox to logarithmically change the dimming of the LEDs. 

If this checkbox is not selected, dimming values are handled as direct values. If the checkbox is selected, 

the specified value is converted to logarithmic value. 

 

4. 3 DALI Mode Setting 
 

In this mode, the LEDs are dimmed by using the DALI protocol. 

DALI (Digital Addressable Lighting Interface) is an international open standard lighting control communication 

protocol, mainly used for light control of multiple fluorescent lamps or LED lights. 

 

 

 
 

(1) Select the [DALI] button in Dimmer Program. 

(2) Open the [DALI Property] dialog box by clicking the [Variable] button, and then specify the parameter. For 

details about this setting, see the [DALI Property] dialog box described in CHAPTER 5 WINDOW 

REFERENCE. 

(3) IEC62386-102 ed2.0 is available for the setting of the memory bank. Open the [DALI Property 

Memorybank] dialog box by clicking the [Memorybank] button, and then specify the parameter. For details 

about this setting, see the [DALI Property Memorybank] dialog box described in CHAPTER 5 WINDOW 

REFERENCE. 

(4) Click icon or select Menu → [File] → [Save] to save the project. 
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4. 4 Generation, Writing, and Evaluation 
 

Object codes (*.hex) are automatically generated and software is written to a microcontroller. 

After writing has been completed, the operation can be checked by using the evaluation board. 

The writing procedure differs depending on the board used. 

 

(1) Click  icon to open the Build window. Preparation for generating object codes (*.hex) and writing will 

be performed. 
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Remark If an abnormality occurs during object code generation (*.hex) or flash writing, an error code may be 

displayed. 

 Example: "code = xx" 

 Take the following countermeasures according to the code number (xx) displayed. 

 
 

Code No. Countermeasures 

2 Applilet EZ for DALI Control Gear may not be correctly installed. Reinstall it. 

3 Data cannot be written because the folder that should be set via the [Folders...] setting on the [Setting] 

menu does not exist. 

Re-set an appropriate folder. 

4 The compiler or assembler selected via the [Compiler] setting on the [Setting] menu cannot be found. 

Check whether the compiler or assembler is correctly selected and installed. If it still cannot be found, 

reinstall the compiler or assembler. 

5 The compiler or assembler selected via the [Compiler] setting on the [Setting] menu is not correctly 

installed. 

Reinstall the compiler or assembler. 

9 The folder set via the [Folders...] setting on the [Setting] menu or the BASEPROJECT folder in the 

installation folder of Applilet EZ for DALI Control Gear is set as a read-only folder. 

Cancel the read-only setting for the whole folder. 

23 This is a system error of the compiler or assembler selected via the [Compiler] setting on the [Setting] 

menu or the main body of Applilet EZ for DALI Control Gear. 

Handle this error by checking the following points. 

If a read-only folder or file exists under the folder set via the [Folders...] setting on the [Setting] menu, 

cancel all read-only settings. 

If the error still cannot be fixed, reinstall the compiler or assembler and the main body of Applilet EZ for 

HCD Controller. 

26 Illegal value of DALI propaty. Details of the error are displayed by text as below. If two or more errors 

exist, only the first detected error is displayed. 

"Power-On Level" < "Min. Level", "Power-On Level" > "Max. Level", 

"System Failure Level" < "Min. Level", "System Failure Level" > "Max. Level" 

"Min. Level" < "Physical Min. Level", "Min. Level" > "Max. Level", "Min. Level" < 1 

"Min. Level" > 254, "Max. Level" < "Min. Level", "Max. Level" > 254,  

"Max. Level" < 1, "Fade Rate" < 1, "Fade Rate" > 15, "Fade Time" < 1 

"Fade Time" >15, "Random Address" < 0x000000, "Random Address" > 0xFFFFFF 

 

(2) Writing preparation 

 If the board has a USB interface 

 Check that the PC and the evaluation board are correctly connected with a USB cable. 

 Depending on the evaluation board, there are those that require switching the features of "write / normal 

operation" by the DipSW. After checking the manual of each evaluation board, when needing setting change, 

turn on the power in the state of writing. 

 

 If the board is using E1 

 Connect the PC, E1 and the evaluation board to each other correctly. 

 Depending on the evaluation board, there are those that require switching the features of "write / normal 

operation" by the DipSW. After checking the manual of each evaluation board, when needing setting change, 

turn on the power in the state of writing. 



Applilet EZ for DALI Control Gear CHAPTER 4 APPLILET EZ FOR HCD CONTROLLER OPERATION 

    

 15 R11UT0078EJ0100  Rev.01.00 
June 15, 2020 

(3) Writing 

<R> If the board has a USB interface 

 Click [OK] and flash programming is started. 
 

 

↓ 

 
 

<R> If the board is using E1 

 Click [OK] and flash programming is started. 

 
 

 

↓ 

 
 



Applilet EZ for DALI Control Gear CHAPTER 4 APPLILET EZ FOR HCD CONTROLLER OPERATION 

    

 16 R11UT0078EJ0100  Rev.01.00 
June 15, 2020 

(4) Operating preparation 

<R> If the board has a USB interface 

When the program has been written normally, turn the evaluation board off. 

If it is necessary to switch features of "write / normal operation", turn on the power of an evaluation board 

again after switching to "normal operation ". 

 

<R> If the board is using E1 

After the writing of the program is completed successfully, turn off the power to the board, and then remove 

the E1. 

If it is necessary to switch features of "write / normal operation", turn on the power of an evaluation board 

again after switching to "normal operation ". 

 

(5) Operating 

 The operation will start immediately when the power is turned ON. 

 

Remark When only generating object codes (*.hex), click  icon. 
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CHAPTER 5 WINDOW REFERENCE 

5. 1 Overview of Windows and Dialog Boxes 
 

The following windows and dialog boxes are provided with Applilet EZ for DALI Control Gear. 

 

Table 5-1 List of Windows and Dialog Boxes in Applilet EZ for DALI Control Gear 

Window/Dialog Box Name Description 

Main window This window is opened automatically when Applilet EZ for DALI Control 

Gear is started. 

This window is used to select and set all functions to be included in the 

automatically generated object codes. 

[DALI Property] dialog box This dialog box is used to save variable settings of DALI. 

[DALI Property Memorybank] dialog box This dialog box is used to set memory bank configuration of DALI. 

It's effective only at the time of selection of IEC62386-102 ed2.0. 

[Board Property] dialog box This dialog box is used to set the evaluation board. 

For details, refer to 4.2. 

[Setting to use Compiler] Set the installed folder of the compiler to use. 

For details, refer to 3.1.1. 

[FLASH Programming Settings] 

dialog box 

This dialog box is used to set flash programming. 

For details, refer to 3.1.1. 

[Project Folder] dialog box This dialog box is used to set a folder into which the generated file is to be 

saved. 

For details, refer to 3.1.1. 
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5. 2 Description of Windows and Dialog Boxes 
 

The following format is mainly used to describe Applilet EZ for DALI Control Gear’s windows and dialog boxes. 

 

Window/dialog box name 
 

The name of the window or dialog box is indicated in this text frame. 

Next, the window or dialog box’s functions are described briefly and an illustration of the window or dialog box is 

shown. 

 

Menu bar 
 

The options that appear in pull-down menus under each item in the window’s menu bar are enumerated and 

described briefly. 

 

Tool bar 
 

The functions corresponding to the buttons in the window’s tool bar are described. 

 

Description of function-related areas 
 

The areas corresponding to functions set via the dialog box are described below. 

 

Function buttons 
 

The various function buttons in the dialog box are described. 

 

Other 
 

Operation methods, functions, and other noteworthy items or caution points are described. 
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Main window 
 

This window is opened automatically when Applilet EZ for DALI Control Gear is started. 

Setting items (Setting up the evaluation board, mode setting (refer to 4.2 and 4.3), etc.) are sequentially selected 

in this window to automatically generate object codes (*.hex) that can be directly written to the flash memory of a 

microcontroller. 

 

Figure5-1 Main Window 

 

 

 

 

 
 

 

 

The following parts of this window are described below. 

 Menu bar 

 Tool bar 

 

Note  For the mode setting area, refer to 4.3 Mode Setting. 

Menu bar Tool bar Mode setting areaNote 

Setting content display 
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Menu bar 
 

(1)  [File] menu 

 
[Create New] This option is used to create a new setting. 

Clicking the  button selects the same function. 

[Open...] This option is used to open an existing setting file. 

Use the dialog box that opens for this option to select the existing setting file (*.xml). 

Clicking the  selects the same function. 

[Save] This option is used to save the current settings. 

Clicking the  button selects the same function. 

[Save as...] This option is used to save the current settings with a newly named. 

[Exit] This option is used to close Applilet EZ for DALI Control Gear. 

[Read Sample Project…] This option is used to read a setting file created as a sample. 

The dialogue box specified the folder that the sample setting file is saved is displayed. 

Please select the sample setting file to use. 

 

(2)  [Project] menu 

 
[Cpu...] This option is used to open the [Board Property] dialog box which sets an evaluation 

board. 

[DALI...] This option is used to open the [DALI Property Variable] dialog box which sets DALI. 

 

(3)  [Build] menu 

 
[Generate and Build] Executes automatic generation of object codes (*.hex). 

Clicking the  button selects the same function. 

[FLASH Programming] Writes an already generated object codes (*.hex). 

Clicking the  button selects the same function. 

[All procedure] Executes automatic generation and writing of object codes (*.hex). 

For the procedures from generation to writing, refer to 4.4 Generation, Writing, and 

Evaluation. 

Clicking the  button selects the same function. 
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(4)  [Setting] menu 

 
[Select Compiler] Select the compiler to be used. 

[Compiler Folder...] This option is used to open the [Setting to use compiler] dialog box which sets 

Compiler installed folder to use. 

[FLASH Program...] This option is used to open the [FLASH Programming Settings] dialog box which sets 

flash programming. 

[Project Folder...] This option is used to open the [FLASH Programming Settings] dialog box which sets 

folder to save the generated files. 

 

(5)  [Help] menu 

 
[Version...] This option is used to display version information about Applilet EZ for DALI Control 

Gear. 

 

Tool bar 
 

The icons on the Tool bar are provided to enable one-click selection of frequently used menu items. 

 

 This selects the same function as when [Create New] is selected in the [File] menu. 

 This selects the same function as when [Open...] is selected in the [File] menu. 

 This selects the same function as when [Save] is selected in the [File] menu. 

 This selects the same function as when [Generate and Build] is selected in the [Build] 

menu. 

 This selects the same function as when [FLASH Programming] is selected in the 

[Build] menu. 

 This selects the same function as when [All procedure] is selected in the [Build] menu. 
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[DALI Property Variable] dialog box (IEC62386-102 ed2.0) 
 

This dialog box can be opened by clicking [DALI...] in the [Project] menu or clicking [Variable] after selecting the 

edition to [IEC62386-102 ed2.0]. 

Set parameter of DALI in this dialog box. 

 

Figure5-5 [DALI Property] dialog box 

 

 
 

The following parts of this window are described below. 

 Description of function-related areas 

 Function buttons 

 

Description of function-related areas 
 

(1) Short Address: 

Specify the default address of the evaluation board (as a value from 0 to 63 and 255). 

 

Caution When the short address is assigned to the same address of the mounted LED channels, a right 

result may not be acquired in command replies such as Query. 

 
  

(13) 

(1) 
(2) 

(3) 
(4) 
(5) 

(6) 
(7) 

(8) 
(9) 

(10) 
(11) 
(12) 
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(2) Random Address: 

Specify a value when assigning a random address to the evaluation board. 

Set random address value (0 to 255) to Random Address(H),(M),(L). 

 

Caution When the Random Address(H),(M),(L) are assigned to the same address of the mounted LED 

channels, a short address cannot be set definitely in Random Address Allocation. 

 

(3) Physical Min. Level: 

Specify physical minimum dimming level (as a value from 1 to 254) of the connected lamp on the 

evaluation board or the evaluation board. 

 

(4) Power-On Level: 

Specify the dimming level for when turning on power (as a value from 1 to 255). 

 

(5) System Failure Level: 

Specify the dimming level for when a failure occurs (as a value from 0 to 255). 

 

(6) Max. Level: 

Specify the maximum dimming level (as a value from the minimum level to 254). 

 

(7) Min. Level: 

Specify the minimum dimming level (as a value from the physical minimum level to the maximum level). 

 

(8) Fade Rate: 

Specify the amount by which the dimming level is changed by fading (as a value from 1 to 15). 

 

(9) Fade Time: 

Specify the time required for the dimming level to be changed by fading (as a value from 0 to 15). 

 

(10) Extended Fade Time Base: 

Specify base value of the extended fade time of dimming (as a value from 0 to 15). 

 

(11) Extended Fade Time Multiplier: 

Specify multiplier value of the extended fade time of dimming (as a value from 0 to 4). 

 

(12) Specific Mode: 

Specify the time (0 and as a value from 128 to 255) required for the dimming level to be changed. 

 

(13) Group 

Specify the group the evaluation board belongs to. Multiple groups can be specified. 
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Function buttons 
 

Button Description 

 Click this button to save the current settings and close the open dialog box. 

 Click this button to close the open dialog box without saving the current settings. 

 
  



Applilet EZ for DALI Control Gear CHAPTER 5 WINDOW REFERENCE 

    

 25 R11UT0078EJ0100  Rev.01.00 
June 16, 2020 

[DALI Property Memorybank] dialog box (IEC62386-102 ed2.0) 
 

This dialog box can be opened by clicking [Memorybank] after selecting the edition to [IEC62386-102 ed2.0]. 

Set Memorybank parameter of DALI in this dialog box. 

 

Figure5-7 [DALI Property Memorybank] dialog box 

 

 
 

 
 

 

(2) (4) 

(1) 

(9) 

(11) 

(10) 

(3) 

(5) 

(6) 
(7) 
(8) 
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The following parts of this window are described below. 

 Description of function-related areas 

 Function buttons 

 

Description of function-related areas 
 

(1) Selection Memorybank TAB 

Select the Memorybank to be set. 

 

(2) GTIN byte: 

Set GTIN: Global Trade Item Number (international standard for product identification code) of evaluation 

board. 

 

(3) Hardware Version: 

Set Hardware Version [major] [minor] of evaluation board. 

 

(4) Identification number byte: 

Set the Identification number of evaluation board. 

 

(5) channel TAB : 

Select the logical device of the evaluation board. 

 

(6) 101 version number: 

Select the IEC62386-101 version number to be used on the evaluation board. 

 

Caution This item is common to all channels. This can be set only on youngest TAB of channel number. 

 

(7) Number of logical control gear unit in the bus unit: 

Set the number of connected Control gear on the same BUS unit. 

 

Caution This item is common to all channels. This can be set only on youngest TAB of channel number. 

 

(8) Index number of this logical control gear unit: 

Set the index number of Control gear connected on the same BUS unit (as a value from 1 to Number of 

logical control gear unit in the bus unit - 1). 

This number is used as Short Address Number in Random Address Allocation. 

 

Caution As for this number, the overlap on the same BUN unit is not forgiven. When overlapping, it 

becomes the overlap error in Random Address Allocation and cannot set Short Address 

Number. 
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(9) OEM GTIN byte: 

Set the GTIN (the international standard for product identification code) that OEM of the evaluation board 

sets. 

 

(10) OEM Identification number byte: 

Set the Identification number that OEM of evaluation board sets. 

 

(11) Indicator byte: 

Purpose and the set value of this byte are left to the manufacturer. Set the value the manufacturer has 

decided (as a value from 0 to 255). 

 

Function buttons 
 

Button Description 

 Click this button to save the current settings and close the open dialog box. 

 Click this button to close the open dialog box without saving the current settings. 
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